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Basic Excel formulas & functions

This topic aims to teach you the essentials of Excel functions and show how to use basic
formulas in Excel.

o Excel formula basics
. 10 basic Excel functions you should definitely know
o Excel formula tips and how-to's

The basics of Excel formulas

Before providing the basic Excel formulas list, let's define the key terms just to make sure we are
on the same page. So, what do we call an Excel formula and Excel function?

o Formula is an expression that calculates values in a cell or in a range of cells.

For example, =A2+A2+A3+A4 is a formula that adds up the values in cells A2 through
Ad.

o Function is a predefined formula already available in Excel. Functions perform specific
calculations in a particular order based on the specified values, called arguments, or
parameters.

For example, instead of specifying each value to be summed like in the above formula, you can
use the SUM function to add up a range of cells: =SUM(A2:A4)

You can find all available Excel functions in the Function Library on the Formulas tab:

Home Insert Page Layout Data Review View Farmulas
AR * |7 AR =

Insert  AutoSumn Recently Financial Logical Text Date & Lookup & Math&  More
Function - Used ~ - - =  Time~ Reference~ Trig~ Functions -

Function Library

There exist 400+ functions in Excel, and the number is growing by version to version. Of
course, it's next to impossible to memorize all of them, and you actually don't need to.
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The Function Wizard will help you find the function best suited for a particular task, while
the Excel Formula Intellisense will prompt the function's syntax and arguments as soon as you
type the function's name preceded by an equal sign in a cell:

A B C

1
2
3
4

S5UM(nu |:|:1ber1_. [number2], ...)

Clicking the function's name will turn it into a blue hyperlink, which will open the Help topic for
that function.

Tip. You don't necessarily have to type a function name in all caps, Microsoft Excel will

automatically capitalize it once you finish typing the formula and press the Enter key to complete
it.

10 Excel basic functions you should definitely know

What follows below is a list of 10 simple yet really helpful functions that are a necessary skill for
everyone who wishes to turn from an Excel novice to an Excel professional.

SUM

The first Excel function you should be familiar with is the one that performs the basic arithmetic
operation of addition:

SUM(numberl, [number2], ...)

In the syntax of all Excel functions, an argument enclosed in [square brackets] is optional, other
arguments are required. Meaning, your Sum formula should include at least 1 number, reference
to a cell or a range of cells. For example:

=SUM(B2:B6) - adds up values in cells B2 through B6.

=SUM(B2, B6) - adds up values in cells B2 and B6.

If necessary, you can perform other calculations within a single formula, for example, add up
values in cells B2 through B6, and then divide the sum by 5:

=SUM(B2:B6)/5
To sum with conditions, use the SUMIF function: in the 1st argument, you enter the range of

cells to be tested against the criteria (A2:A6), in the 2nd argument - the criteria itself (D2), and in
the last argument - the cells to sum (B2:B6):
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=SUMIF(A2:A6, D2, B2:B6)

In your Excel worksheets, the formulas may look something similar to this:

A B C D E F G H
Item Qty. Total 11| =SUM(B2:B6)
Apples Apples 4| =SUMIF[A2:A6, D2, B2:B6)
Oranges

Lemans

Oranges
Apples

L Rl L Rd

Tip. The fastest way to sum a column or row of numbers is to select a cell next to the numbers
you want to sum (the cell immediately below the last value in the column or to the right of the
last number in the row), and click the AutoSum button on the Home tab, in the Formats group.
Excel will insert a SUM formula for you automatically.

Useful resources:

e Excel Sum formula examples - formulas to total a column, rows, only filtered (visible)
cells, or sum across sheets.

o Excel AutoSum - the fastest way to sum a column or row of numbers.

o SUMIF in Excel - formula examples to conditionally sum cells.

e SUMIFS in Excel - formula examples to sum cells based on multiple criteria.

AVERAGE

The Excel AVERAGE function does exactly what its name suggests, i.e. finds an average, or
arithmetic mean, of numbers. Its syntax is similar to SUM's:

AVERAGE(numberl, [number2], ...)

Having a closer look at the formula from the previous section (=SUM(B2:B6)/5), what does it
actually do? Sums values in cells B2 through B6, and then divides the result by 5. And what do
you call adding up a group of numbers and then dividing the sum by the count of those numbers?
Yep, an average!

The Excel AVERAGE function performs these calculations behind the scenes. So, instead of
dividing sum by count, you can simply put this formula in a cell:

=AVERAGE(B2:B6)

To average cells based on condition, use the following AVERAGEIF formula, where A2:A6 is
the criteria range, D3 is he criteria, and B2:B6 are the cells to average:

=AVERAGEIF(A2:A6, D3, B2:B6)
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A B C D E F G H

Item aty. Average

Apples 1 All items 2.2| =AVERAGE([B2:B6)

Qranges 2 Apples 2| =AVERAGEIF{AZ:AB, D3, B2:B6)
Lemons 3

Oranges 2

Apples 3

Useful resources:

Excel AVERAGE - average cells with numbers.

Excel AVERAGEA - find an average of cells with any data (numbers, Boolean and text
values).

Excel AVERAGEIF - average cells based on one criterion.

Excel AVERAGEIFS - average cells based on multiple criteria.

How to calculate weighted average in Excel

How to find moving average in Excel

MAX & MIN

The MAX and MIN formulas in Excel get the largest and smallest value in a set of numbers,
respectively. For our sample data set, the formulas will be as simple as:

=MAX(B2:B6)

=MIN(B2:B6)

[ T O IR "y TN N6 TR

il B C D E F G
ltem Qty. Max 3| =MAX(B2:Ba)
Apples Min 1| =MIN(B2:BE6)
Oranges
Lemomns
Oranges
Apples

L Rl L R e

Useful resources:

e MAX function - find the highest value.

e MAXIF formula - get the highest number with conditions.

o MAXIFES function - get the largest value based on multiple criteria.

e MIN function - return the smallest value in a data set.

e MINIFS function - find the smallest number based on one or several conditions.

NDOLA TRUST SCHOOL (2020)


https://www.ablebits.com/office-addins-blog/2015/08/28/excel-average-averageif/#AVERAGE-function
https://www.ablebits.com/office-addins-blog/2015/08/28/excel-average-averageif/#AVERAGEA-function
https://www.ablebits.com/office-addins-blog/2015/08/28/excel-average-averageif/#AVERAGEIF-function
https://www.ablebits.com/office-addins-blog/2015/08/28/excel-average-averageif/#AVERAGEIFS-function
https://www.ablebits.com/office-addins-blog/2015/09/25/moving-average-excel/
https://www.ablebits.com/office-addins-blog/2015/09/25/moving-average-excel/
https://www.ablebits.com/office-addins-blog/2019/10/16/max-function-excel-highest-value/
https://www.ablebits.com/office-addins-blog/2019/10/30/excel-max-if-formula/
https://www.ablebits.com/office-addins-blog/2019/10/23/maxifs-function-excel-find-max-value-multiple-criteria/
https://www.ablebits.com/office-addins-blog/2019/11/14/min-function-excel/
https://www.ablebits.com/office-addins-blog/2019/11/19/minifs-function-excel/

COUNT & COUNTA

If you are curious to know how many cells in a given range contain numeric values (numbers or
dates), don't waste your time counting them by hand. The Excel COUNT function will bring you
the count in a heartbeat:

COUNT(valuel, [value2], ...)

While the COUNT function deals only with those cells that contain numbers, the COUNTA
function counts all cells that are not blank, whether they contain numbers, dates, times, text,
logical values of TRUE and FALSE, errors or empty text strings ("):

COUNTA (valuel, [value2], ...)

For example, to find out how many cells in column B contain numbers, use this formula:
=COUNT(B:B)

To count all non-empty cells in column B, go with this one:

=COUNTA(B:B)

In both formulas, you use the so-called "whole column reference” (B:B) that refers to all the cells
within column B.

The following screenshot shows the difference: while COUNT processes only numbers,
COUNTA outputs the total number of non-blank cells in column B, including the the text value
in the column header.

A B C D E F G
1 ltem Qty. Mumber count 5| =COUNT(B:B)
2 Apples 1 Mon-blank count 6| =COUMTA(B:B)
3 |Oranges 2
4 |Lemons 3
5 |Oranges 2
6 Apples 3

Useful resources:

o Excel COUNT function - a quick way to count cells with numbers.

o Excel COUNTA function - count cells with any values (non-empty cells).
e Excel COUNTIF function - count cells that meet one condition.

e Excel COUNTIFS function - count cells with several criteria.
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IF

Judging by the number of IF-related comments on our blog, it's the most popular function in
Excel. In simple terms, you use an IF formula to ask Excel to test a certain condition and return
one value or perform one calculation if the condition is met, and another value or calculation if
the condition is not met:

IF(logical_test, [value_if true], [value_if false])

For example, the following IF statement checks if the order is completed (i.e. there is a value in
column C) or not. To test if a cell is not blank, you use the "not equal to" operator (<>) in
combination with an empty string (""). As the result, if cell C2 is not empty, the formula returns
"Yes", otherwise "No™:

=IF(C2<>""", "Yes", ""No"")

D2 - =IF(C2<="", "Yes", "No")
A B C D "

1 Item Qty. Delivery date Completed?

2 |Apples 1 1-Sep-19i‘

3 Oranges 2 2-5ep-19 Yes

4 |Lemons 3 1-5ep-19 Yes

5 |Oranges 2 Mo

6 Apples 3 3-5ep-19 Yes

Useful resources:

e |F function in Excel with formula examples
e How to use nested IFs in Excel
o |F formulas with multiple AND/OR conditions

TRIM

If your obviously correct Excel formulas return just a bunch of errors, one of the first things to

check is extra spaces in the referenced cells (You may be surprised to know how many leading,
trailing and in-between spaces lurk unnoticed in your sheets just until something goes wrong!).

There are several ways to remove unwanted spaces in Excel, with the TRIM function being the
easiest one:

TRIM(text)

For example, to trim extra spaces in column A, enter the following formula in cell A1, and then
copy it down the column:
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=TRIM(AL)

It will eliminate all extra spaces in cells but a single space character between words:

c2 e =TRIM{A2)

A B C ‘
1 |Data Trim formula|
2 |1apple |1 apple l
3 | 2apples 2 apples
4 |3 apples 3 apples
5 | 4 apples 4 apples
6 |3 apples 5 apples

Useful resources:

Excel TRIM function with formula examples

How to delete line breaks and non-printing characters
How to remove non-breaking spaces (&nbsp;)

How to delete a specific non-printing character

LEN

Whenever you want to know the number of characters in a certain cell, LEN is the function to
use:

LEN(text)

Wish to find out how many characters are in cell A2? Just type the below formula into another
cell:

=LEN(A2)

Please keep in mind that the Excel LEN function counts absolutely all characters including
spaces:

c2 v =LEN(A2)

A B ‘ C
1 Data Len formula
2 |1apple ?_l
3 2apples
4 |35 apples

Want to get the total count of characters in a range or cells or count only specific characters?
Please check out the following resources.
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Useful resources:

Excel LEN formulas to count characters in a cell

Count a total number of characters in a range

Count specific characters in a cell

Count specific character in a range

AND & OR

These are the two most popular logical functions to check multiple criteria. The difference is

how they do this:

AND returns TRUE if all conditions are met, FALSE otherwise.
OR returns TRUE if any condition is met, FALSE otherwise.

While rarely used on their own, these functions come in very handy as part of bigger formulas.

For example, to check the test results in columns B and C and return "Pass" if both are greater
than 60, "Fail" otherwise, use the following IF formula with an embedded AND statement:

=IF(AND(B2>60, B2>60), "'Pass", "'Fail"")

If it's sufficient to have just one test score greater than 60 (either test 1 or test 2), embed the OR

statement:

=IF(OR(B2>60, B2>60), "Pass", "Fail")

=|F{AND{B4=60, C4=60), "Pass", "Fail")

A

A B C D1
1 | Passif both tests are greater than 60

2

3 Iltem Testl Test2 Pass/ Fail
a |ava 75 70| Pass

5 |Aiden 60 64 Fail

6 |Jackson 82 B0 Pass

7 |Liam 73 75 Pass

8 Sophia 61 58 Fail

Useful resources:

o Excel AND function with formula examples

o Excel OR function with formula examples
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=IF{OR(B4>60, C4>60), "Pass", "Fail")

A

Pass if either test is greater than 60

B

C

D

A

Item
|Ava
Aiden
Jackson
Liam
Sophia

Test1

82
73

Test 2

70
b4
80
75
38

Pass [ Fail |

Pass
Pass
Pass
Pass
Pass



https://www.ablebits.com/office-addins-blog/2016/06/08/excel-len-functions-count-characters-cell/
https://www.ablebits.com/office-addins-blog/2016/06/15/how-to-count-characters-excel/#characters-in-a-range
https://www.ablebits.com/office-addins-blog/2016/06/15/how-to-count-characters-excel/#specific-characters-in-a-cell
https://www.ablebits.com/office-addins-blog/2016/06/15/how-to-count-characters-excel/#specific-characters-in-a-range
https://www.ablebits.com/office-addins-blog/2014/12/17/excel-and-or-xor-not-functions/#excel-and-function
https://www.ablebits.com/office-addins-blog/2014/12/17/excel-and-or-xor-not-functions/#excel-or-function

CONCATENATE

In case you want to take values from two or more cells and combine them into one cell, use the
concatenate operator (&) or the CONCATENATE function:

CONCATENATE(text1, [text2], ...)

For example, to combine the values from cells A2 and B2, just enter the following formula in a
different cell:

=CONCATENATE(A2, B2)

To separate the combined values with a space, type the space character (" ") in the arguments
list:

=CONCATENATE(A2, " ", B2)

D2 - =CONCATENATE(A2," ",B2)

A B C “ D
1 Qty. ltem Concatenate formula
2 | 1 apple 1 apple _|
3 2 oranges 2 oranges
4 3 cherries 3 cherries

Useful resources:

How to concatenate in Excel - formula examples to combine text strings, cells and columns.

TODAY & NOW

To see the current date and time whenever you open your worksheet without having to manually
update it on a daily basis, use either:

=TODAY/() to insert the today's date in a cell.
=NOW() to insert the current date and time in a cell.

The beauty of these functions is that they don't require any arguments at all, you type the
formulas exactly as written above.

A B c
1 |Today's date Wednesday, May 24, 2017 =TODAY()
2 Current date & time 05/24/2017 14:30 =NOW]()
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Useful resources:

How to insert today's date in Excel - different ways to enter the current date and time in Excel: as
an unchangeable time stamp or automatically updatable date and time.

Excel date functions with formula examples - formulas to convert date to text and vice versa,
extract a day, month or year from a date, calculate the difference between two dates, and a lot
more.

Excel formulas tips and how-to's

Now that you are familiar with the basic Excel formulas, these tips will give you some guidance
on how to use them most effectively and avoid common formula errors.

Copy the same formula to other cells instead of re-typing it

Once you have typed a formula into a cell, there is no need to re-type it over and over again.
Simply copy the formula to adjacent cells by dragging the fill handle (a small square at the
lower right-hand corner of the cell). To copy the formula to the whole column, position the
mouse pointer to the fill handle and double-click the plus sign.

=IF(A2>=3, "OK", "Not OK")

A s

A C 3] E
1 |Data If formula
2 | 1|Not oK & Drag or double-click
3 2 to copy the formula to
4 3 the whaole column.
5 4
& 3

Note. After copying the formula, make sure that all cell references are correct. Cell references
may change depending on whether they are absolute (do not change) or relative (change).

How to delete formula, but keep calculated value

When you remove a formula by pressing the Delete key, a calculated value is also deleted.
However, you can delete only the formula and keep the resulting value in the cell. Here's how:

Select all cells with your formulas.

Press Ctrl + C to copy the selected cells.

Right-click the selection, and then click Paste Values > Values to paste the calculated values
back to the selected cells. Or, press the Paste Special shortcut: Shift+F10 and then V.
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Do not enclose numbers in double quotes

Any text included in your Excel formulas should be enclosed in "quotation marks". However,
you should never do that to numbers, unless you want Excel to treat them as text values.

For example, to check the value in cell B2 and return 1 for "Passed", 0 otherwise, you put the
following formula, say, in C2:

=IF(B2=""pass"", 1, 0)

Copy the formula down to other cells and you will have a column of 1's and O's that can be
calculated without a hitch.

Now, see what happens if you double quote the numbers:
=IF(B2="pass"", ""1"", "'0"")

At first sight, the output is normal - the same column of 1's and 0's. Upon a closer look, however,
you will notice that the resulting values are left-aligned in cells by default, meaning those are
numeric strings, not numbers! If later on someone will try to calculate those 1's and 0's, they
might end up pulling their hair out trying to figure out why a 100% correct Sum or Count
formula returns nothing but zero.

c2 - =IF{B2="pass", 1,0) | v c2o- =IF(B2="pass", "1", "0")| X
A B C “ D A B C “ D

1 |Name Result . 1 |Name Result

2 |Ava Fail D-_ 2 |Ava Fail 0 ]

3 |Aiden Pass 1 3 |Aiden Pass 1

4 |Jackson  Fail 1] 4 |Jackson  Fail 0

5 |Liam Pass 1 5 |Liam Pass 1

6 Sophia  Pass 1 6 Sophia  Pass 1

7 |Lucas Pass 1 7 |Lucas Pass 1

8 Passed 4 =SUM|C2:C7) 8 Passed 0 =SUM|C2:C7)

Don't format numbers in Excel formulas

Please remember this simple rule: numbers supplied to your Excel formulas should be entered
without any formatting like decimal separator or dollar sign. In North America and some other
countries, comma is the default argument separator, and the dollar sign ($) is used to make
absolute cell references. Using those characters in numbers may just drive your Excel crazy :)
So, instead of typing $2,000, simply type 2000, and then format the output value to your liking
by setting up a custom Excel number format.
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Match all opening and closing parentheses in your formulas

When crating a complex Excel formula with one or more nested functions, you will have to use
more than one set of parentheses to define the order of calculations. In such formulas, be sure to
pair the parentheses properly so that there is a closing parenthesis for every opening parenthesis.
To make the job easier for you, Excel shades parenthesis pairs in different colors when you enter
or edit a formula.

Make sure Calculation Options are set to Automatic

If all of a sudden your Excel formulas have stopped recalculating automatically, most likely
the Calculation Options somehow switched to Manual. To fix this, go to the Formulas tab
> Calculation group, click the Calculation Options button, and select Automatic.

What is Formulas in Excel?

FORMULAS IN EXCEL is an expression that operates on values in a range of cell addresses
and operators. For example, =A1+A2+A3, which finds the sum of the range of values from cell
Al to cell A3. An example of a formula made up of discrete values like =6*3.

=A2*D2/2
HERE,

"="tells Excel that this is a formula, and it should evaluate it.

o "A2"* D2" makes reference to cell addresses A2 and D2 then multiplies the values found
in these cell addresses.

e "["is the division arithmetic operator

e "2"isadiscrete value

Formulas practical exercise
We will work with the sample data for the home budget to calculate the subtotal.
o Create a new workbook in Excel

o Enter the data shown in the home supplies budget above.
e Your worksheet should look as follows.
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A B
Home supplies budget

5/N ltem aty
| 1 Mangoes

2 Oranges

3 Tomatoes

4 Cooking Qil

5 Tonic water

T L

0O =] o Ln

We will now write the formula that calculates the subtotal

Set the focus to cell E4
Enter the following formula.
=C4*D4

HERE,

Ln = w WO

13

1200
2500
8500
3900

FORMULA

— GOES HERE
C4D4

e "C4*DA4" uses the arithmetic operator multiplication (*) to multiply the value of the cell

address C4 and DA4.
Press enter key

You will get the following result

E4 -
Formula
B

Home supplies budget

1
2
3 5/N ltem aty
4 | 1 Mangoes

2 Oranges

3 Tomatoes

4 Cooking Qil

5 Tonic water

[ v B I = ¥ )]

Jx | =caspa

LN = o

13

Formula
gvaluation result

The following animated image shows you how to auto select cell address and apply the same

formula to other rows.
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1 Home supplies budget

2

3 /8/N Item Qty Price Subtotal

4 |1 Mangoes 9 600

5|2 Oranges 3 1200

& |3 Tomatoes 1 2500

7 14 Cooking Qil 5 6500

8 |5  Tonicwater 13 3900

9

10

N

12
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READY HH M o -—F—+ 100%

Mistakes to avoid when working with formulas in Excel

1. Remember the rules of Brackets of Division, Multiplication, Addition, &

Subtraction (BODMAS). This means expressions are brackets are evaluated first. For
arithmetic operators, the division is evaluated first followed by multiplication then
addition and subtraction is the last one to be evaluated. Using this rule, we can rewrite the
above formula as =(A2 * D2) / 2. This will ensure that A2 and D2 are first evaluated then
divided by two.

2. Excel spreadsheet formulas usually work with numeric data; you can take advantage of
data validation to specify the type of data that should be accepted by a cell i.e. numbers
only.

3. To ensure that you are working with the correct cell addresses referenced in the formulas,
you can press F2 on the keyboard. This will highlight the cell addresses used in the
formula, and you can cross check to ensure they are the desired cell addresses.

4. When you are working with many rows, you can use serial numbers for all the rows and
have a record count at the bottom of the sheet. You should compare the serial number
count with the record total to ensure that your formulas included all the rows.
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What is Function in Excel?

FUNCTION IN EXCEL is a predefined formula that is used for specific values in a particular
order. Function is used for quick tasks like finding the sum, count, average, maximum value, and
minimum values for a range of cells. For example, cell A3 below contains the SUM function
which calculates the sum of the range AL:A2.

e SUM for summation of a range of numbers

« AVERAGE for calculating the average of a given range of numbers
e COUNT for counting the number of items in a given range

The importance of functions

Functions increase user productivity when working with excel. Let's say you would like to
get the grand total for the above home supplies budget. To make it simpler, you can use a
formula to get the grand total. Using a formula, you would have to reference the cells E4 through
to E8 one by one. You would have to use the following formula.

=E4+E5+E6+E7+ES8

With a function, you would write the above formula as

=SUM (E4:E8)

As you can see from the above function used to get the sum of a range of cells, it is much more

efficient to use a function to get the sum than using the formula which will have to reference a
lot of cells.

Common functions

Let's look at some of the most commonly used functions in ms excel formulas. We will start with
statistical functions.

S/IN FUNCTION CATEGORY DESCRIPTION USAGE
01 SUM Math & Trig Adds all the values in a range of cells =SUM(E4:E8)
- Finds the minimum value inarange _ .
02 MIN Statistical =MIN(E4:E8)
of cells
03 MAX Statistical Finds the maximum value in a range ~MAX(E4:ES)

of cells

Calculates the average value in a =AVERAGE(E4:E

04 AVERAGE Statistical
range of cells 8)
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S/IN FUNCTION CATEGORY DESCRIPTION USAGE

Counts the number of cells in a range

05 COUNT Statistical
of cells

=COUNT(E4:ES)

06 LEN Text Re_turns the number of characters in a —LEN(B7)
string text

Adds all the values in a range of cells
07 SUMIF Math & Trig that meet a specified criteria.
=SUMIF(range,criteria,[sum_range])

=SUMIF(D4:D8,">
=1000",C4:C8)

Calculates the average value in a

range of cells that meet the specified — AVERAGEIF(F4:

08 AVERAGEIF Statistical criteria. ot A
=AVERAGEIF(range,criteria,[averag F8,"Yes",E4:E8)
e_range])

09 DAYS Date & Time Returns the number of days between _DAYS(D4,C4)
two dates

10 NOW Date & Time Returns the current system date and “NOW()

time
Numeric Functions

As the name suggests, these functions operate on numeric data. The following table shows some
of the common numeric functions.

SINFUNCTION CATEGORY DESCRIPTION USAGE

Returns True if the supplied value is numeric

1 ISNUMBER Information o . =ISNUMBER(A3)
and False if it is not numeric

2 RAND Math & Trig Generates a random number between 0 and 1 =RAND()

3 ROUND Math & Trig Rounds off a decimal value to the specified ~ROUND(3.14455,2)

number of decimal points

4 MEDIAN  Statistical Retgrns the number in the middle of the set “MEDIAN(3,45.2,5)
of given numbers

5 PI Math & Trig Returns the value of Math Function PI(xr)  =PI()

Returns the result of a number raised to a

6 POWER Math & Trig power. POWER( number, power )

=POWER(2,4)
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SINFUNCTION CATEGORY DESCRIPTION USAGE

Returns the Remainder when you divide two

7 MOD Math & Trig numbers

=MOD(10,3)
8 ROMAN Math & Trig Converts a number to roman numerals =ROMAN(1984)

String functions

These basic excel functions are used to manipulate text data. The following table shows some of
the common string functions.

S/ FUNCTI CATEGO
N ON RY DESCRIPTION USAGE COMMENT

Returns a number of specified
1 LEFT  Text characters from the start (left-hand
side) of a string

=LEFT("GURU99", Left 4 Characters
4) of "GURU99"

Returns a number of specified
2 RIGHT Text characters from the end (right-hand
side) of a string

Right 2
Characters of
"GURU99"

=RIGHT("GURU99
Il,2)

Retrieves a number of characters

from the middle of a string from a ~MID("GURU99" 2, Retrieving

3 MID Text specified start position and
length. =MID (text, start_num, 3) GUELE IR
num_chars)
4 ISTEXT Informatio Returns Trye if the supplied ~ISTEXT(value) value - The value
n parameter is Text to check.
Returns the starting position of a
text string within another text string. _ . . Find oo in
5 FIND  Text This function is case- _,I,:Ill;lD( 00", ROOfIn"Roofing",
sensitive. =FIND(find_text, g Result is 2
within_text, [start_num])
Replaces part of a string with
5 REPLAC Text another specified =REPLACE("Roofi Replace "00"
E string. =REPLACE (old_text, ng",2,2,"xx") with "xx"

start_num, num_chars, new_text)

Date Time Functions

These functions are used to manipulate date values. The following table shows some of the
common date functions
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SINFUNCTION CATEGORY DESCRIPTION

1 DATE Date & Time _Returns the number that represents the date
in excel code

2 DAYS Date & Time Find the number of days between two dates

3 MONTH Date & Time Returns the month from a date value

4 MINUTE Date & Time Returns the minutes from a time value

5 YEAR Date & Time Returns the year from a date value

VLOOKUP function

USAGE

=DATE(2015,2,4)

=DAYS(D6,C6)
=MONTH("4/2/2015")
=MINUTE("12:31")

=YEAR("04/02/2015")

The VLOOKUP function is used to perform a vertical look up in the left most column and return
a value in the same row from a column that you specify. Let's explain this in a layman's
language. The home supplies budget has a serial number column that uniquely identifies each
item in the budget. Suppose you have the item serial number, and you would like to know the
item description, you can use the VLOOKUP function. Here is how the VLOOKUP function

would work.
VLOOKUP - x v K =VLOOKUP[C12,A4:B8,2,FALSE) v
A B C D E
- VLOOKUP
Home supplies budget table array range Formula
2
3 IS}’N Item ' Price Subtotal Isit Affordable?
4 /1 Mangoes 9 600 5400 Yes
5|2 Oranges 3 1200 3600 Yes
6 |3 Tomatoes 1 2500 2500 Yes
7|4 Cooking Oil 5 6500 32500 Mo
8 |5 Tonic water i 7 3900 27300 Mo
g
Home 5uppli|=5 VLOOKUP
12 | ltem S/N: | ZlDES-EriptiD-l'l: |=VLGGKLHI display
13 result
Seach here

=VLOOKUP (C12, A4:B8, 2, FALSE)

HERE,
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o "=VLOOKUP" calls the vertical lookup function

e "C12" specifies the value to be looked up in the left most column

o "A4:B8" specifies the table array with the data

e "2" specifies the column number with the row value to be returned by the VLOOKUP
function

e "FALSE," tells the VLOOKUP function that we are looking for an exact match of the
supplied look up value

The animated image below shows this in action

E12 - x v K ||T v
A B C D E F G [«

1 |Home supplies budget

2

3 5/N Item Qty Price Subtotal Is it Affordable?

4 11 Mangoes 9 600 5400 Yes

5|2 Oranges 3 1200 3600 Yes

6 |3 Tomatoes 1 2500 2500 Yes

74 Cooking Qil 5 6500 32500 Mo

8 |5 Tonic water 7 3900 27300 No

g

10

11 Home supplies VLOOKUP

12 Item 5/N: Description: | |

13 -

* Functions sample dal ... () 4 3

Summary
Excel allows you to manipulate the data using formulas and/or functions. Functions are generally

more productive compared to writing formulas. Functions are also more accurate compared to
formulas because the margin of making mistakes is very minimum.

Here is a list of important Excel Formula and Function
e SUM function = =SUM(E4:E8)
e MIN function = =MIN(E4:E8)

« MAX function = =MAX(E4:ES8)
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« AVERAGE function = =AVERAGE(E4:E8)

e COUNT function = =COUNT(E4:ES8)

« DAYS function = =DAYS(D4,C4)

e VLOOKUP function = =VLOOKUP (C12, A4:B8, 2, FALSE)

o DATE function = =DATE(2020,2,4)

IF, AND, OR, Nested IF & NOT Luogical Functions in Excel

Things will not always be the way we want them to be. The unexpected can happen. For
example, let's say you have to divide numbers. Trying to divide any number by zero (0) gives an
error. Logical functions come in handy such cases. In this topic, we are going to cover the
following topics.

In this topic, we are going to cover the following topics.

« What is a Logical Function?

o |F function example

o Excel Logic functions explained
o Nested IF functions

What is a Logical Function?

It is a feature that allows us to introduce decision-making when executing formulas and
functions. Functions are used to;

e Check if a condition is true or false
e Combine multiple conditions together

What is a condition and why does it matter?
A condition is an expression that either evaluates to true or false. The expression could be a

function that determines if the value entered in a cell is of numeric or text data type, if a value is
greater than, equal to or less than a specified value, etc.
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IF Function example

We will work with the home supplies budget from this topic. We will use the IF function to

determine if an item is expensive or not. We will assume that items with a value greater than
6,000 are expensive. Those that are less than 6,000 are less expensive. The following image

shows us the dataset that we will work with.

A E ¢ D E F |

Home supplies budget (1?":&_5{:.&@ yes ff-'r\
suibfotals less

S/N Item Qty Price Subtotal Isit Affordable? Hhan .000.

1 Mangoes 9 600 5400 Displan No For

2 Oranges 3 1200 3600 i i’ B

3 Tomatoes 1 2500 2500 svbfotal greater

4  Cooking Oil 5 6500 32500 fhan (000

5  Tonicwater 7 3900 27300 L\ )

e Put the cursor focus in cell F4
o Enter the following formula that uses the IF function

=IF(E4<6000,"Yes","No")

HERE,

"=IF(...)" calls the IF functions

o "E4<6000" is the condition that the IF function evaluates. It checks the value of cell
address E4 (subtotal) is less than 6,000

e "Yes" this is the value that the function will display if the value of E4 is less than 6,000

e "No" this is the value that the function will display if the value of E4 is greater than

6,000

When you are done press the enter key

You will get the following results
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Excel Logic functions explained

M

5/N
|1
2

=] O Ln e La ra

3
4
]

(]

E

Item
Mangoes
Oranges
Tomatoes
Cooking Oil
Tonic water

J ((IF(Ea<6000,"ves","No") )

C D E F

0]

Home supplies budget

Qty Price Subtotal Is it Affordable?
9 600  5400|Yes ]
3 1200 3600
1 2500 2500
3 6200 32300
7 3900 27300

The following table shows all of the logical functions in Excel

S/
N

01

02

03

FUNCTI
ON

AND

FALSE

CATEG
ORY

Logical

Logical

Logical

DESCRIPTION

Checks multiple conditions and returns
true if they all the conditions evaluate to
true.

Returns the logical value FALSE. It is
used to compare the results of a
condition or function that either returns
true or false

Verifies whether a condition is met or
not. If the condition is met, it returns
true. If the condition is not met, it
returns

false. =IF(logical_test,[value_if true],[
value_if_false])
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USAGE

=AND(1 >
0,ISNUMBER(1)) The
above function returns
TRUE because both
Condition is True.

FALSE()

=IF(ISNUMBER(22),"Yes",
"No")

22 is Number so that it
return Yes.
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04

05

06

07

08

Nested IF functions

IFERRO
R

IFNA

NOT

OR

TRUE

Logical

Logical

Logical

Logical

Logical

Returns the expression value if no error
occurs. If an error occurs, it returns the
error value

Returns value if #N/A error does not
occur. If #N/A error occurs, it returns
NA value. #N/A error means a value if
not available to a formula or function.

Returns true if the condition is false and
returns false if condition is true

Used when evaluating multiple
conditions. Returns true if any or all of
the conditions are true. Returns false if
all of the conditions are false

Returns the logical value TRUE. Itis
used to compare the results of a
condition or function that either returns
true or false

=IFERROR(5/0,"Divide by
zero error'™)

=IFNA(D6*E6,0) N.B the
above formula returns zero if
both or either D6 or E6 is/are
empty

=NOT(ISTEXT(0)) N.B. the
above function returns true.
This is because ISTEXT(0)
returns false and NOT
function converts false to
TRUE

=OR(D8="admin",E8="cash
ier") N.B. the above function
returns true if either or both
D8 and E8 admin or cashier

TRUE()

A nested IF function is an IF function within another IF function. Nested if statements come
in handy when we have to work with more than two conditions. Let's say we want to develop a

simple program that checks the day of the week. If the day is Saturday we want to display "party
well", if it's Sunday we want to display "time to rest”, and if it's any day from Monday to Friday
we want to display, remember to complete your to do list.

A nested if function can help us to implement the above example. The following flowchart
shows how the nested IF function will be implemented.
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Yes

Party well To do List

The formula for the above flowchart is as follows
=IF(B1="Sunday","time to rest",IF(B1="Saturday","party well","to do list"))
HERE,

"=IF(....)" is the main if function

"=IF(...,IF(....))" the second IF function is the nested one. It provides further evaluation

if the main IF function returned false.
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Practical example

Ho ¢ -

FILE HOME =~ Guru®  INSERT  FORMULAS  DATA  Team ! Rodrick Kazembe ~
L ‘Calibri *|11 | == = % ConditionaIFﬂ-rmatting* E‘“Insert v #
Psltj - B I U- A a === - .05 9 [FFormat as Table~ £X Delete ~ Editing

aste —
. W HL HoA- EE=E - S H (7 Cell Styles - &l Format~ -
Clipboard r Font Ta Alignment o Mumber T Styles Cells A
B3 bt J(t‘ =IF{B1="5unday","time to rest",IF(B1="Saturday","party well","to do list"}) w
A B C D E F 3

1 |Enter day of the week: Sunday

2 %

3 |Daily tip: time to rest

4

5

1] -
| Sheetl | Nested If @ [ | [

HoE M -———t—7:=+

Create a new workbook and enter the data as shown below

A B C

Day of the week: Saturday

,
2
3 |Greeting:
F ]

QOur results will be
displayed here

« Enter the following formula
=IF(B1="Sunday","time to rest",IF(B1="Saturday","party well","to do list"))

o Enter Saturday in cell address B1
e You will get the following results
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=IF{B1="Sunday","time to rest", IF(B1="Sajurday","party well","to do list"))

A B
1 |Day of the week:| Saturday
2

3 |Greeting: |part','well _l

Summary

Logical functions are used to introduce decision-making when evaluating formulas and functions
in Excel.

How to Create Charts in Excel: Types & Examples

A picture is worth of thousand words; a chart is worth of thousand sets of data. In this topic, we
are going to learn how we can use graph in Excel to visualize our data.

What is a chart?

A chart is a visual representative of data in both columns and rows. Charts are usually used
to analyse trends and patterns in data sets. Let's say you have been recording the sales figures in
Excel for the past three years. Using charts, you can easily tell which year had the most sales and
which year had the least. You can also draw charts to compare set targets against actual
achievements.

We will use the following data for this topic.

Note: we will be using Excel 2013. If you have a lower version, then some of the more advanced
features may not be available to you.

Item 2012 2013 2014
Desktop Computers 20 12 13
Laptops 34 45 40
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Monitors 12 10 17

Printers 78 13 90

Types of charts

Different scenarios require different types of charts. Towards this end, Excel provides a number
of chart types that you can work with. The type of chart that you choose depends on the type
of data that you want to visualize. To help simplify things for the users, Excel 2013 and above
has an option that analyses your data and makes a recommendation of the chart type that you
should use.

The following table shows some of the most commonly used charts and when you should
consider using them.

S/ CHART WHEN SHOULD I USE IT? EXAMPLE
N TYPE

1 Pie Chart When you want to quantify items and

show them as percentages. Pie chart

=

Series "Desktop
" 2012+ 2013 value: 12 (21%)

2 Bar Chart When you want to compare values

: Bar Chart

across a few categories. The values
run horizontally 2015

PR m—

2012 —

0 20 40 60 B0 100
Printers Monitors
M Laptops B Desktop Computers
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Column
chart

Line
chart

Combo
Chart

When you want to compare values
across a few categories. The values
run vertically

When you want to visualize trends
over a period of time i.e. months,
days, years, etc.

When you want to highlight different
types of information

The importance of charts

Allows you to visualize data graphically

It's easier to analyse trends and patterns in the charts

Easy to interpret compared to data in cells

NDOLA TRUST SCHOOL (2020)

100
80
60

20

180
160
140
120
100
80
&0
40
20

&0
40
20

Column Chart

I_IHH I_IHI_I HHI_I I_IHI_I

2012 2013 2014 2015

@ Desktop Computers @ Laptops

E Monitors Printers
LINE CHART
—a#— Desktop Computers —E—Llaptops —&—
F £ o
— = -
2012 2013 201.
Combo Chart
2012 2013 2014 :

mm Desktop Computers s Laptops

e [0 M TOMS Printers


https://www.guru99.com/images/5-2015/050215_0900_Visualizing3.png
https://www.guru99.com/images/5-2015/050215_0900_Visualizing4.png
https://www.guru99.com/images/5-2015/050215_0900_Visualizing5.png

Step by step example of creating charts in Excel

In this topic, we are going to plot a simple column chart that will display the sold quantities

against the sales year.

e Open Excel
o Enter the data from the sample data table above
e Your workbook should now look as follows

To get the desired chart you have to follow the following steps
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N20 - fr /Sa'es Year
A E C D E

1 202 2013 2014 2015
2 |Desktop Computers 12 13 .
3 |Laptops 34 a5 40 39
4 IMonitors 12 10 17 15
5 |Printers 78 13 90 14
&

7| Items sold
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E -2 e Sales Dataxlsy - Excel
FILE HOME  Guru39  INSERT ~ FORMULAS ~ DATA  POWERPNOT  Team

B ERE e 0 ¥ mrE

2-D Col
PivotTable Recommended Table  Pictures Online E ‘M Aops * H Recommended oumn 'ower  Line Column Wi
) i oo e My Apps i
PivotTables Pictures @i+ Charts View L
Tables [Nustrations Apps ’-ﬂ-‘ JH JH eports Sparklines
E5 T ﬁ' 14 3-D Column
A B C D E F G Jﬂm ﬂ@ ]@ K L
1 2012 2013 2014 2015
2 |Desktop Computers 20 12 13 12
3 |Laptops 34 45 40 39 ﬂ@
£ |Monitors 0 2 0 7 5
5 |Eas i - - 1 il More Column Charts..
® 1. Highlight the data e
7| 2. Click on INSERT tab
8 | 3, Click on Column chart drop down button
9 | 4. Select chart type
10

o Select the data you want to represent in graph
e Click on INSERT tab from the ribbon

e Click on the Column chart drop down button
o Select the chart type you want

You should be able to see the following chart

I Chart Titlé I

100
20
g0
Y
&0
50
40

30

2 I

1

o Ilal =iz s} =iN

2012 2013 2014 2015

(=R =]

m Desktop Computers @ laptops m Monitors Printers
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Topic Exercise

When you select the chart, the ribbon activates the following tab

H % : Sales Dataxls - Ficel CHARTTOOLS
AT HOME  Guu®9  INSERT  FORMULAS  DATA  POWERPNOT  Team  DESIGN  FORMAT

L] s - s -
Ih 5 ot} 4
Add Chat Quick  Change | bbbl 1 it e ML CRRLRE L BE L | SwitchRow/ Select
Element  Layout~ Colars~ Column  Data
Chart Layouts Chart Styles Data
Chat7 fy

Try to apply the different chart styles, and other options presented in your chart.

Download the above Excel Template

Summary

Charts are a powerful way of graphically visualizing your data. Excel has many types of charts
that you can use depending on your needs.

Conditional formatting is also another power formatting feature of Excel that helps us easily see
the data that meets a specified condition
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